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TSDS PEIMS Fall Submission Data for
Business

Created: 10/1/2024
Reviewed: 10/16/2025
Revised: 10/16/2025

This document outlines key Business data that is submitted during the Public Education Information
Management System (PEIMS) Fall Submission and used by the Texas Education Agency (TEA). As
the year progresses, this document may be updated to include additional fields of data.

For more information about the TSDS reporting process, review the TSDS Training Materials
webpage:
https://www.texasstudentdatasystem.org/tsds/about/training-and-support/tsds-training-materials

This document assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

| Some of the images and/or examples provided in this document are for informational
£2% % purposes only and may not completely represent your LEA's process.

For a complete list of submission rules and edits, access the TSDS Web-Enabled Data
Standards (TWEDS) website:
https://tealprod.tea.state.tx.us/TWEDSAPI/30/0/0/Overview?Introductionld=952. In the
top-right corner, select the appropriate School Year (20XX), Collection (PEIMS), and
Submission (Fall) and click Open.

Once on the TWEDS website, in the Overview tab, you can review Collections,

& Timelines (DUE DATES), and Data Submission Responsibilities. It is highly
important to ensure that you review all of these details as they may change according
to the School Year.

Additionally, you can use the other tabs on the TWEDS website to review Data
Components, Descriptor Tables, References, Rules, Change Logs, and Early
Notices.
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Prerequisites

Review the following and take action as needed:

O Ensure applicable employees have the correct roles and permissions in ASCENDER Security
Administration to access pages needed for TSDS reporting.

O Review TSDS Best Practices for New Employee Records.
O Review TSDS Best Practices for Terminated Employee Records.

O Create responsibility records in Personnel for staff whose Staff Service begins with “S.” Review
the Responsibilities - Quick Reference Chart.

* The underlined text indicates the domain's submission level as it appears on the District
Administration > Options > TSDS > Domains & Entities page.

I. Education Organization Domain

First Level Submission

Review TSDS Web-Enabled Data Standards for the Education Organization domain.

@

The Education Organization domain includes information about public, charter, education service
center, organization, or agency.

Information from AskTED is imported into the Operational Data Store (ODS). As you send data,
TEA matches the School ID (county district number) to existing district and campus information
to ensure that the reported data is credited to the correct Local Education Agency (LEA).

1. Verify district information for current/prior school year.
Verify district information for current/prior school year

District Administration > Tables > District Information > District Name/Address
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Year [ Retricve J Save ]
DISTRICT NAME / ADDRESS ~ CAMPUS NAME/ADDRESS ~ PAYROLL FREQUENCIES ~ REPORTING CONTACT  SHARED SERVICES ARRANGEMENT  FUND BALANCES
District Name: [TExas D |
District County Name: [ TEXAS Crty ] District Tvpt"

Jistrict Wibsite [wnm:sczl:l nict ]

DHstrict E-mail (info@esc20.net |

ESC Region Number ESC County District Number:[_057-950 )

Strect Nor: Street Name: [Lone Star Drive |

City: (Atama City ] state:[ T - Texas v| zip[za178 ]+ ]
Phone: (155 |)(see-0es7 | Fax[sss)  |[s10-8413 ]

O In the Year field, type the four-digit school year for which you want to add or retrieve data
and click Retrieve.

O Verify the ESC Region Number and ESC County District Number are accurate. The ESC
County District Number is the six-digit ESC county district number assigned by Texas
Education Agency (TEA).

ESC County District Numbers

O Click Save for each year; each year is a separate record.

2. Verify campus information/exclude non-instructional campuses from reporting.

Verify campus information/exclude non-instructional campuses from
reporting

District Administration > Tables > District Information > Campus Name/Address

Ensure the Exclude from reporting to TEA checkbox is selected for all non-instructional
campuses/departments to exclude them from being reported to TEA.
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= | [ hewee  J[ s
DISTRICT NAME [ ADDRESS CAMPUS NAME | ADDRESS PAYROLL FREQUENCIES REPORTING CONTACT SHARED SERVICES ARRANGEMENT FUND BALAMNCES
Campus: [999 - 9499 School v] [ Hetreve ] I Add l [ Delet [ Print
Camgpus ID: 539
Campus Marme: [999 School ]
Swreet Mbe: 1407 Sirest Name: | 999 Steet )
City: [a:l.:fnn City ] 5‘!.:1:.[1:-: - Texas v] z:p.[@hu'ﬂb ]+[ ]
Phone: (N | (W ]
Exclude from reporting to TEA:

O In the Year field, type the four-digit school year for which you want to add or retrieve data
and click Retrieve. The Year is automatically updated when the Fiscal Year Close process is
completed in Finance.

[ Retrieve each campus record and confirm that the address and phone numbers are accurate.

O Review the following guidelines as consideration for selecting the Exclude from reporting
to TEA checkbox:

o Instructional campuses listed in AskTed (001, 041, 101, etc.) should not have the
Exclude from reporting to TEA checkbox selected.

o Non-instructional campuses (701, 750, 999, and other campuses or departments needed
for purchasing) should have Exclude from reporting to TEA selected.

o Education Service Centers (ESCs): Exclude all campuses from TEA reporting.

o Business-only LEAs: Exclude all campuses from TEA reporting.

O Click Save for each campus; each campus is a separate record.

3. Verify Shared Services Arrangements, as needed.
Verify Shared Services Arrangements, as needed

District Administration > Tables > District Information > Shared Services Arrangement
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DeSTRICT NAME [ ADDRESS CAMPLUS MAME | ADDRESS PAYROUL FREQUENCIES REPORTING CONTACT SHARED SERVICES ARRANGEMENT FUND BALANCES FALL ANANCE TS0 DATA  PRIOR SHARED SERVICES ARRANGEMENT

Shared Services Amangeeents

Dwtete  Shared Servces Timd Bl Apsm Distnat 10

] [e2): 00150

O In the Year field, type the four-digit reporting year for which you want to add or retrieve data
and click Retrieve. For example, the reporting year for the 2025-2026 school year is 2026.

[0 Under Shared Services Arrangements, enter all Shared Services Arrangements for which

the LEA is a member or the fiscal agent. Indicate the Shared Services Type and Fiscal Agent
District ID.

Note: Since each year is entered on this tab, there are not separate tabs for the current
and prior years as in previous years.

O Click Save.

Il. Staff Domain

Second Level Submission

@ Review TSDS Web-Enabled Data Standards for the Staff domain.

The Staff Domain includes general staff information for a Local Education Agency (LEA).

This section provides you with a clear view of all the Business fields included in the Staff Domain for
Fall PEIMS reporting. The information is organized by where it exists in the system (application, menu,
page, and tab). This will help you easily locate and correct data as needed.

1. Personnel
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Personnel Report

Personnel > Reports > Personnel Reports > HRS1250 - Employee Data Listing

This report allows you to verify demographic, responsibilities, salary, and account data for
employees, one employee per page.

Use the Include Reports parameter to select Personnel, Job, Responsibility, and Distributions.

|
@ TIP: You can also generate user-created reports to assist you in verifying data.

= )= |

[ Clear Oplions ]

Personnel
HES1000 - Boster of Personnel
HRES1050 - Employes Birthday List
HES1100 - Employes Verification Beport
HES1300 - Federsl EEOC Regort
HRES1250 - Employves Dats Listing
HRS1400 - Tescher Service Record
HES1450 - Employes Mailing Labels
HES1500 - Empleyves Education Report
HES1S50 - Mew Hire Repart
HRES1800 - Certification Heport
HRS1650 - Employes Salary |nformation
HES1 700 - Socisl Security Muimber Werification
HREGL7 = Ta@gh I it Adkotr ‘.!:I!'i"“!ﬂﬂ

HRS51250 - Employes Data Lsting
Parameter Description ‘Walue
Sort by Algha (Al Pay Campes (C). Primary Campus )

Include Reports (Select From List)
Include SSN on Regort? (Y/N)

From Last Name (3 Letters)

To Last Mame (3 letters)

Pay Status Active [A), Inactive (1), o blank for ALL
Pay Type 1-4. or blank for ALL

Select Pay Campusles). of blank for ALL
Select Primary Campusies), or blank for ALL
Select Extract 1D, or blank for ALL

Select Employee]s). or blank for ALL

E-mail Subject

E-mad Message

Fiom Pay Date (MMDDYYYY), or blank for ALL
To Pay Date (MMDDYYYY), o blank for ALL
Select Frequency

Inclusde Number of Days Employed / in Contract on Report? (YN} | ¥

include Reports

E Pgrsonevel

D Payroll

(] ote

D TRS

[0 calendar YTD
[0 Schoct ¥TD
D Lesve

[0 Deduction

E Digtrilsulion
E] Responsibaity

D Permit

S| E—
_|

|
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= 4 b o=
Dt Rur: Employes Data Listing Program: HRS1250
[Cnity Dist: ISD Pagec 1of 2
Frequency: B
Emp Nbr: 001604 Emp Mame:  STEWART, SHARON ELISABETH
Payroll Mame & Primary Address Former Name & Allemate Address Prmary Campus: 101 - ASCENDER Middle Schaol
Last  STEWART Last: Payroll Campus: 101 - ASCENDER Middle School
First  SHARON First: Info Restrict N Gender.  F-Female
Middle: ELISABETH Middle: Restnct Public- N Mantal Stat: M - Marmed
Tuthe: Gen: Tithe: Gen: Local Area 1: Birth Date:  07-24-1979
Street 20300 TRUMAN DR Street: Local Area 2: Last Chg:  08-10-2020
City'St: Alamo City. TX City'St Dirvers Lick: 21512429 T
ZpCd 28178 Zip Cd: DL Expir Date: 07-24-2021 Deceased: N
Country. TRS Beg. Dt 07-20-2020
Phone: (555)576-6743 Cell: { ) BusPh: [ ) Bus Ext Citizen: Y
ik E-mail Hm E-mail HispanicLatino [] BlackiAfrican American O
Supplemental Address: Asian a Amencan Indian/Alaskan Native []
Delivery Name: hite 2 tm Hawanan/Other Pacific =)
Emergency Contact JFFY NDN Relaticn: SPOUSE Bilingual
Phone: (555)286-1308 Ext
Emergency Notes:
Personnel Information
Employee Status: 2 - Active awallary per Onginal Emp.Date:  07-20-2020 Primary Job Code: 0056 - MMS OFFICE/CLERICAL
Highest Degrea: 0 - No Bachelor's Latest Reemploy Date: Primary EEOC: 15 - ClericalSec staff
Percent Day Employed: 100% Retirernent Diate: Percent Assign: 100%
Eligle for Rehire: 1 Take Retiree Surcharge:  [J Paraprofessional Certificaion: [
Extract ID: 216 - 216-DiY WY Take Retiree a Paraprofessional Cert Effective Date:
Surcharge:
V-2 Elec Consent Year Round: o
10895 Elec Consent: ERS Retires Health Elig: a Employment Type: F - Hal-Time or more
Retree Employment Type:
~ Exparience NY ERS Retire Health Elig:  [J
Professional Mon-Professional | — Contract Informatkon Extended Leave Termination
Total: Total 05 Class: X -0THER
In Destrict: In Destrict: 05 Term:  NO - NO CONTRACT Begin: Date:
Creditable Year of Serace: O Year. NO-NOT APPLICABLE End: Reason:
Grade(s) Taught Begir: 07-14-2025 Full Semester: [
Yrs Prior Teaching: 0 End:  06-13-2026
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Job Information
— Calendar Info — State Info

ﬁcw:m - MMS OFFICECLERICAL Calendar 10216 DAYS TRS Year

it Begin Date: 07-14-2025 | | State Step:
Incr Pay Step: & End Date: 06-18-2026 | | TRS Mbe Pos: 03 - Support staff
Primary Campus: 101 - ASCENDER Middle School Payoff Date: 07-24-2026 | | *rs in Career Ladder. 0
Job Dept: Nbe of Days Empld: 216 | | Retiree Exception:
E:':;"‘ &::“'g”’d Eg‘(' — Contract Info — Accral Info
Pay Siep o Contract Amt: 34.904.00 | | Accrue Code:
Sabad Contract Batance: 3199533 | | Aocrual Rate 000
MaxDays: - Nbe of Annual Pymis: 12
Hbe Days OF 0 Remaining Pymis: 11 | — State Min Salary
Hrs/Day: 000 No of Months in Contract 11| | Percent Assigned:  100%
EEOC: 5. eallSac staff Nbr of Days in Contract: 0 State Min.Salary: .00
Pay Type: 2 - Non-cortracied emp — Dailty Rate r— Standard Pay Rate
Reg Hrs Worked: .00 Daily Rate of Fay: 161.583 | | FayRate 290867
Exempt Status a

Account Distribution Information

0056 - MMS OFFICE/CLERICAL

Extra

TRS WC Exp Emplr Perd

HAocount Code Description Amount Percent Account Type Duty AchityCode Grant Code 373 Conr Pay
199-23-6129.00-101-611000 SUPPORT SALARIES 34.904.00 1.000 G - Standard 80 - Base Salary B
Staff Responsibilites

[ind of Repoat

Saaff Coop/554 Pop SPEDStdent MNor Monthly ESC/  Job
Campus Classification LEA Snvd AgeFange  Stu Minutes SSA  Code BeginDate EndDate  ear
001 - ASCENDER High Schaal 033 01 08000 07-08-2024

TIP: All new staff should be entered in Personnel and Payroll on the same day by
. 6pm (if possible). If the required staff data is not available or cannot be entered
f,. the same day, the recommended best practice is to set the Employee Status
@ field to 0 - Pending to prevent the record from being included in the overnight
extract with incomplete information. Be sure to review TSDS Best Practices for
New Employee Records.

Personnel

Personnel > Maintenance > Staff Demo > Demographic Information
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L= ]

Emplovee: [ ] [ e || oweiry || Aswcen || tsosunqun |
DEMOGRAPHIC INFORMATION CREDENTIALS VERIFICATION INSURANCE SERVICE RECORD RESPONSIBILITY
Staff ID/SSMN Texas Umnigue Staff ID: : Last Change: 08-02-2024
[« =1 ) ) | ] (=2l )
e 9 | ) ) | 2
tle First Middle Last Generation

Sex: Citizenship Driver's License: :] DL State: (T Texas ~)
DOE: Aarital Stat Deceased [ DL Expir Date: Other Language [
Ethnicity Race (check all that apply; must select at least one)
Hispanic/Latino D American Indian Alaskan Native D Native Hawaiian Pacific lstander D
Asian D White
Black African American [:]

When adding new Personnel and Payroll records in ASCENDER, it is highly recommended to
create the records on the same day. This allows the Begin and End Dates to be extracted
correctly during the automatic extract at 6 PM. Verify that the following fields are complete:

o Staff ID/SSN

o Texas Unique Staff ID

o First, Middle, and Last Name

o Generation

o Sex

o DOB

Ethnicity (if applicable)

Race (check all that apply; must select at least one)

[¢]

o

Personnel > Utilities > Mass Update > Responsibility

TIP: Before running a mass update, enter an End Date on the responsibility
I records for any employees who have been terminated or reassigned. This prevents
© ended responsibilities from being copied forward.
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Parameters Beset
Pay Stalus Oractive (O Insctive (8) Both )
Primary Camgpus: L Payoff Date:
Pay Type: o [ J
Pay Campus: w —
Iob Cobe Frequency: [au v
Contract Begin Date L A
Acorual Code: “ Salary Concent s
Contract End Date: | Extract IDx l v]
T — —
Contract Months: Employes Nbe :]=

Prior ¥r Emp Date:| 00-00-000(C

EMPLOYEE RESPONSIBILITY

Copy Ewecuts

From Te

] e —

O Under Parameters, select the appropriate parameters for the employees whose
responsibility data is to be updated.

O Under Copy, in the School Year field:

From|Type the school year from which you want to copy responsibility records in the YYYY
format.

To |Type the school to which you want to copy responsibility records in the YYYY format.

Note: The From School Year is the prior year and the To School Year is the current
year.

O Click Execute to execute the process. A preview report is displayed. The report only lists
available responsibilities to be copied based on the set parameters. Duplicates are not allowed.
Review the report.

O Click Process to proceed.

A message is displayed indicating that the process was completed successfully.

Personnel > Maintenance > Staff Demo > Responsibility
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Employee El}ﬂlﬁl:d STEWART, SHARGHN ELISABETH Hitrvim ] | CHrectary ]

DEMOGRAPHIC INFORMATION CREDENTIALS  VERIFICATION  INSURANCE SERVICE RECORD RESPOMSIBILITY

Delete  Details Yo — Campus Staff Classficaton Staff Service
7 (8] 2026 001 - ASCENDER High School 033 - Educational Alde  SAD00003
o 2025 001 - ASCENDER Hegh School 033 - Ecucationad Alde  SA000003

Sehool Yeor for PEIMS Codes: 2026

Job Code | | Staff Service: | SA000003 - Instructional Educational Aide |
Campus: [ 001 ASCENDER High School v| SPED Student Age Range: | 00 Mot Providing Services o Special Education Students v
Co-op/55A LEA: :] Pop Served: [D'. Fegular Studenis v]
Staft Classification: [033 - Ecucational Aute |8 Mooty b [ oaooo |
ESC/S5A: [ Scnoct Distict Emplayes | # of Students: oo

Sesn e

End Date: [o0-00-0000]
Notes:

o Employees can have multiple responsibility records for the same year, provided that
each record has a different Staff Service value.

o Verify that the School Year for PEIMS Codes is the current PEIMS school year that
you are working in. If the School Year for PEIMS Codes field needs to be updated,
changes can be made on the Personnel > Tables > District HR Options page.

o Campus

o Co-0op/SSA LEA - Co-op staff should be reported by the fiscal agent. Type the nine-digit
ID (six-digit district ID + three-digit campus ID) to identify the LEA (district and campus)
where the SSA/Co-op employees has work assignment records if other than their home
district/campus. If this field is populated, then the Campus field should be blank and vice
versa.

o Staff Classification - This field is previously known as Role ID and identifies the
capacity in which a person serves.

o ESC/SSA - This field can be blank if it is not applicable.

o Staff Service - Refers to the services supplied by staff.

o SPED Student Age Range

o Pop Served

o Monthly Minutes - The total minutes devoted to a particular service in a standard
month. A standard month is the four weeks in October, including the PEIMS Fall snapshot
date (last Friday in October). For example, a class taught for one hour every day would
report 1,200 monthly minutes (60 minutes x 5 days x 4 weeks). This field cannot be
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blank, default value is 00000.

o # of Students (in class) - This field cannot be blank,

o Begin Date

default value is 0.

o End Date- An end date is not required for the 2025 record unless the employee is
terminated, no longer in the position, or the record should be excluded from the Mass

Update process.

= If an End Date is entered, the record will not be copied from 2025 to 2026 during

the year-to-year Mass Update.

= If the employee is continuing in the same position, create a 2026 record so it will be

included in the submission.

TIPS:

o Responsibility records with a Staff Service
Pop Served set to 06.

that begins with SE must have

o Responsibility records for aides must have Number of Students set to 0.

Personnel > Maintenance > Employment Info

Employee: | | |

EMPLOYMENT INFO

Ifmw:amq St

Emplanment Dated

Employed

Emglonrment Typed

Retines Information

‘Original Emp: Date: I Employman: Type: I Retirement Date 000000
Litest e Emlay Dt e L V)  PeEmeometes T 9)
Terreiramion Dats: Hisghily Qualdiud D D
Extracy for TSOS: Year Rourd ] 0
Termanation Heason Extract D
Eligible for Rie-hire I Highest Degres:
Percent Day Employed: 100%
Pet Dy Employed Effecties Date |:|._ 31-3023
Years Experierce Blectronic Consant Service Record Contract information Extended Laave Fingerprint information
P - Professional.- - ™ temester. ] -
Terat: Teaal Gradel
n 5
Dréstrict: [EI Dristric
Prior Teaching:
Credinable Year of
Sarvice
TRA Years Exparience Aumiliary Roke ID Paraprofessional Certification
TRA Teaching Experience: -IJ b
TR Eligikifity: Delete  Auwiliary Role IO Begin Date Enl Dt Delete  Para Cert  Begin Date End Date

il ”~

a ( ] | J [ ] O C_—JC 7]

’ L8

r

To ensure that an employee's TSDS Days Employed Set is calculated correctly and to prevent
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employees from being included on the Unaffiliated Staff list in TSDS, verify that the following
fields are complete:

o Employee Status - Staff records with a pay type of 1-5, A are extracted for TSDS
reporting if the Employee Status is 1 - Active professional, 2 - Active auxiliary per, 3 -
Retired, 4 - Resigned, 5 - On Leave, or A - Long Term Substitute.

o Original Emp Date - The original date on which the individual was employed by the LEA.

o Latest Re-Employ Date - Complete this field if the employee worked for the LEA, left
the LEA, and then returned. Note: Do not delete the Original Emp Date but do delete
Termination Date and Termination Reason.

o Termination Date - Type the date that the termination of the employee went into effect.
The termination date and reason are used to exclude the employee from TEA reporting.

o Termination Reason - Click ™ to select the reason the employee was terminated. The
termination date and reason are used to exclude the employee from TEA reporting.

o Extract for TSDS - Select to include the employee in TSDS Staff Domain extracts
regardless of their employment status. This allows those individuals with a Not
Employed status to be included in the TSDS extract process. This option is useful for job
abandonment instances where a termination date must be entered.

o Percent Day Employed - Type the percentage of a standard district workday for which
the employee is hired to work. For an employee on contract, the percentage can be
determined directly from the contract: full-time = 100, half-time = 050, and so on. For a
non-contract employee, the percentage can be determined as follows. For example, the
standard workday for the LEA is 7 hours. An employee is hired to work for 4 hours per
day. This data element is coded as 057 for the employee because 4/7 = .571 is rounded
down. Employees such as cafeteria workers and bus drivers who work only a few hours
each day should not be reported as 100 in this field. Consider the number of hours
worked in relation to the standard LEA workday, not the job. The field can be a maximum
of three digits.

o Pct Day Employed Effective Date - Reflects the employee's start date or date of hire or
the effective date of when an employee’s percent day employed is changed.

o Highest Degree

o Total Years Professional Experience

o Total Years Experience In District (professional staff only)

o TRA Teaching Experience - Type the two-digit number of verifiable years of teaching
experience as a classroom teacher as described in TEC §48.158. The field default is zero.

o TRA Eligibility - Select to indicate the local education agency (LEA) has determined the
teacher (StaffClassification is 087) is employed by a school system and teaches not less
than an average of four hours each day, in an academic instructional setting or a career
and technology educational setting.

o Auxiliary Role ID, Begin Date and End Date, if applicable (TSDS = Staff Classification)-
Complete this field for auxiliary staff (not aides) paid from 6129. Only one auxiliary role
should be active at a time. If an employee serves in multiple auxiliary capacities, only the
primary duty should be reported.

For TSDS reporting, leave the End Date field blank until the role officially ends. The end
date should reflect the first day after the last day a non-exempt auxiliary staff was
assigned to the AuxiliaryRoleld descriptor (i.e., the day after the last day the employee
held the position).

Note: Professional and paraprofessional staff may also be reported with an Auxiliary Role
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ID if they serve the LEA in a non-professional or non-paraprofessional role. A classroom
teacher (Staff Classification 087) who also drives a bus route for the school would require
an Auxiliary Role ID to be reported. In this case, the employee would have at least two
payroll accounting entries; one with object code 6119 and one with object code 6129.

As there may be duplication between Staff Classification and Auxiliary Role ID, the LEA
must use its discretion in determining if the employee is serving in a professional or non-
professional capacity.

o Paraprofessional Certification, Begin Date and End Date, if applicable - For TSDS
reporting, leave the End Date field blank until the certification expires. The end date
should reflect the day after the last day a para-professional staff was certified (i.e., the
day after the last day that the certification was valid). An employee should generally have
only one active certification for the current year, though a recently expired certification
may still be displayed.

TIPS:

\ o Ensure that all certifications that have ended have an End Date. Delete any
& expired certifications from previous years.
o To keep historical certification records for reference, move them to the
Personnel > Maintenance > Staff Demo > Credentials tab.

Personnel > Maintenance > TSDS Days Employed Set

This page is used to keep a record of the number of days an employee has been employed
for TSDS reporting purposes and manage begin/end dates if corrections are necessary.

This page only applies to employees with Employee Status 1, 2, 3, 4, 5, or A as listed on the
Personnel > Maintenance > Employment Info page. Each record displays the percent of day
employed, the TSDS number of days employed, the begin and end dates, a date timestamp
indicating when the record was created, and the module within the system where the update
originated. A record is created whenever the number of days employed or percent of day
employed is changed. Only one record without an end date is allowed. Note that the # of
Days Employd will be calculated each day during the automatic extract at 6 PM even if a
manual extract and send is executed in District Administration.

This information is reported in the TSDS
StaffEducationOrganizationEmploymentAssociation>DaysEmployedSet and records the
percent and number of days employed by the employee as well as the begin date and end
date associated with the PercentDaysEmployed and NumberDaysEmployed data elements.
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Save ]

Employess [ 000087 | ARVIN, AMANDA REMAE | [ Rutnove J [ Directory J
Peroent Dy Emplerved T505 & Dors Emiboved Bagin Date End Dt Ueedate DTS Module
100% 26 11-09- 2004 l 2024.10-28 21:36:10.103

4 E].'l ¥

2. Payroll

Payroll

Payroll > Maintenance > Staff Job/Pay Data > Job Info

Employee: [DEIlEE?:F'ARSDNS MALUREEN GEME J [ Retrieve J [ Directory ]

PAYINFO  JOBINFO  DISTRBUTIONS  DEDUCTIONS  LEAVE BALANCE

| Detete Selectsd obCode Primary % Assigned Py Tt

o O [oooL-TeacHER ] § Contracted employee
[ (o] [0716 - BUS DRIVER 3 O Non-contracted emp Primary Campus: (001 ASCENDER High Schodt
Dept D
Rows: 204 2 w1 Add
Conftract Info

Pary Type: |2 Non-contracted emp v Pay Grade: 10T w Pay Step: 08 w Sched " Max Days 1HT W Hirs Per Day: Incr Pay Step:

Total: 53 800.00] Balance: 53.600.00) & of Annual Pymis: @ Remasnng Pymits: @ Concept  Use annual salary table

& of Months in Contract: State Min Days: [ODD TRS - Non contract V_] Base Annual: 53 800.00
3 ¥
-
- d Y = j & -] E 3 & 5 Ot r
Dasly Rate- 387701 Contract Total @ ! of Days Empld Days O Wiaeant Job O

Pay Rate: = Contract Total: (585059 /% Annual Pymis: Payoff Date:  ee=e—rarm) Wikdy His Sched: 9
Reg Hrs Warksd OVIMElG )  OVTMRae: WiyRae (—ggg| EsemetSutus: EEOC (16 Service workers v

State Info
State Step: D Yrsin Coreer Ladder: |~ o] TRS Year O TRS Member Pos: 04 Bus driver w| WWhally Sep Amt
State Min - Foundation ® % W & of days = Retires
0.0004 187

Salary: Daily Rate: Assigned: @ Empld - Emcepticn: L \'J
Calendar/Local Info
Calendar Cd: 09 - 187 DAYS 1 [Begn Date: 08-11-2025 End Date: 05-75-2026 # of Digys Empld: Exclude Days for TEA:
Years Job Exp: D Local Contract Days:

187

o Job Code

o Total - This field must be completed for employees with pay types 1, 2, and 3. For Pay
Type 3 (hourly employees), enter an estimate of the annual salary.

o Calendar/Local Info

o Begin Date and End Date

o # of Days Employd: Note that the # of Days Employd will be calculated each day
during the automatic extract at 6 PM even if a manual extract and send is executed in
District Administration.
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the Personnel > Maintenance > TSDS Days Employed Set page.

The TSDS Days Employed Set consists of the Percent Day Employed in
@ Personnel and the # of Days Empld in Payroll. You can verify these days on

o (If applicable) Exclude Days for TEA - If an employee has multiple jobs listed on this
page, the system automatically calculates the total number of days worked across all
jobs. For example, if a teacher works 187 days and has a secondary job as a bus driver for

180 days, by default, the system adds all days for a total of 367 days. This does not

accurately reflect the actual number of days worked since the employee does not actually
work 367 days. To ensure accurate reporting, it is recommended to only report the job
with the highest number of days. For jobs with fewer days, select Exclude Days for TEA

to prevent those days from being included in the total.

3. Position Management

Position Management

Position Management > Maintenance > PMIS Position Admin

Ensure the Exclude Days for TEA checkbox is selected for all secondary jobs.

Position Numbcr[bLiL.'SIJRl\"Ell

Delete Durtails: Bilet
(0] 50001
o s0002
] D 50003
o 50004
D 50005
o S0006
] E] 3|k ||Last

POSITION RECORD:  DISTRIBUTION

Occupant

Sch YR
2025
2024
2026
2026
2025
2025

DATE

)

Position Dwescripticn:

Dwescription

{GLIS DRIVER 216

[eus oRvER 216

[BUS CRIVER

lBUS MOMITOR 226

|BU5 MOMITOR 226

[Bus oRVER

[eUs DRIvER

S W S S ) S
»

BUDGET

Employee Nbr: [001304 ] Emplayee Name: MELODY RENEE PHILLIPS
Primary Job Increase Eligible

Pay Grade: (703 )3 PayStep: (06 )3 Schedule: [__J5  State Step: [__] Bogin Date: [07-01-2025] €nd Date: [06-30-2026 | Payolf Date: [06-25-2026 )3

Days Off Mbr Days Employed: 22600 HourlyDaily Rate Salary: 20.340.00 Remaining Payments welude Days for TEA:

Emp Nbr
000202
000732
001304
001419
001211
001286

First Nama
AUSTIN
JEFFREY
MELODY
PAMELA
MARLA

MELINDA

Migdle Name

ALAN

REMEE

RAE

Last Name
BLUNT
HAMUSA
PHILLIPS
ROBASOM
MICHE

PEPPERS

Gen

The Exclude Days for TEA checkbox can be found on the following Position Management >

Maintenance pages:

o PMIS Position Admin > Position Record
o PMIS Position Modify > Position Record
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o PMIS Positions History > History
o PMIS Change in Position > Change in Compensation
4. District Administration
District Administration
District Administration > Tables > District Information > District Name/Address

Add data for contracted instructional staff as needed.

DISTRICT HAME / ADDRESS  CAMPUS NAME [ ADDRESS PAYROLL FREQUENCIES REPORTING CONTACT SHARED SERVICES ARRANGEMENT FUND BALANCES FALL FNANCE TSDS DATA

District Nama: [TExasiso ]
Diistrict County Mame: [TEXAS Crty ] Distriet Type
[wwesczomet |
Districs E-mail: [..-.-o-.; e 30 et l
ESE Feogion Number ESC County District Number;|_057-950 |
Street Nbr. Street Mame: [Lone Star Drive ]
City [ame Gy ] State [T - Texas v]  Zex[28178 ]+[ ]
Phaone: |55 ][ses-oear ] Faxc[i585)  |(sto-8413 ]

S crm— ] ( ) o ) >

Tiale First Micdle Last Generation

Total Mor School Board Requests: Contracted Instructional Staff

Total Cost School, Board Requests: v Praa -

B B @

O In the Year field, type the four-digit school year for which you want to add or retrieve data
and click Retrieve.

O Under Contracted Instructional Staff, add records and complete the following fields:

o Campus

o Program Intent Code - Identifies the cost of instruction and other services directed
toward a particular need of a specific set of students. The intent (the student group
toward which the instructional or other service is directed) determines the
ClIStaffProgramintent, not the demographic makeup of the students served.

o Number of FTEs - A standard measurement of the portion of professional contracted
instructional staff expressed as a multiple of the standard workday, such as 7.7 FTEs.
When calculating contracted instructional staff FTEs, the following items must be
considered:

o The percent of the day worked (the number of hours worked divided by the number of
work hours in the standard day).
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o The percent of days per week worked (the number of days worked divided by 5).
o The percentage of weeks worked (the number of weeks worked divided by the number of
weeks in the work year).

For example, Mrs. Jones is hired on a contracted instructional staff basis to teach the tuba to
three tuba players. Her contract specifies that she will work two hours each Monday and
each Friday for the entire school year. Her FTE is 0.25 (two hours worked divided by the
eight-hour work day in the district) multiplied by 0.40 (two days divided by five days)
multiplied by 1.0 (36 weeks worked divided by the 36-week instructional year), for a
reported FTE of 0.10.

Note: For information regarding Full-Time Equivalent (FTE) calculations, please refer to the
TWEDS website.

District Administration > Maintenance > Non-Employee

For contracted instructional staff, complete all fields under Instructional Staff.
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Save

NON-EMPLOYEE TSDS

Employee Mbr: (001563 | Name:|SMITH. SANDRA ] [ Retriewe | Directory ] I Add “_
HName
Employee Mbr 001563 Mame | [sAnDRA | ( | [smiTH | { v|
Title First Middle Last Generation
WorkEmal )
Job Code [0151 - SPEECH THERAPIST JE
Highly Qualified: [
Instructional Staff
Local Use
S5M TX Unique Staff ID: | 1234567890
ol S
Date of Birth: 07-01-1973
Races

Hispanic: ] American Indian: [ Asian: [ Black: Pacific Islanger: ]  White: [

R geshnowe
Total Years: End Dake
Diistrict Yoars Extract for TSDS O

Percent of Day Prior Teaching Years
Highest D

0 Be sure to select a TSDS Staff Type code for all non-employees who have a start date within
the PEIMS school year that you are currently working in.

* Select 3 - Contracted Professional Staff if the staff member is a Contracted Professional
(instructional and non-instructional

~

* Select 4 - In-District Charter Prtnr Campus Teacher if the staff member is a teacher employed
at an In-district Charter Partner Campus.

Notes:

o Typically for staff paid out of Finance, not Payroll.
o A non-employee cannot have the same Social Security Number and Texas Unique
Staff ID as an active employee in Personnel or Payroll.

Full-time equivalents (FTEs) are calculated in the following manner:
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o If NumberDaysEmployed is greater than or equal to 187, then FTE =
PercentDayEmployed divided by 100.

o If NumberDaysEmployed is less than 187, then FTE = (PercentDayEmployed divided
by 100) X (NumberDaysEmployed)/187

Base Salary is the total of all PayrollAmount where PayrollActivity is 80 (Base Salary).

FTE Salary is Base Salary divided by FTE.

District Administration > Maintenance > Non-Employee > TSDS

Create TSDS/Responsibility records for non-employees. Note that any updates made to the Non-
Employee tab will not create new records on this tab.

Note: Non-employees can have multiple responsibility records for the same year, provided
that each record has a different Staff Service value.

HOH-EMPCVEE  TSO5

Emghoyee b (001563 | Mame[SMTH SaNDRA ][

TSOS Durys Empleyed Set

Portert Dy Employect TSDS #Dwys Employed  BegnDaste  End Dite
woa W7 08-01-2004

A |1w[it Pk

Raesponnid ity

Delrte  Duetals Yoo Campus Stalf Classification Schocl Yaar for PEIMS Coder: 2008

£ 016 001- ASCENDERHgh Schesl 0L - Echeational Digrostic o Code

(0060 s »| Stat Servion: | 5000001 - Seecal Edusation. Genenc )i
[+] 2005 001 - ASCENDER Hgh Schasl 08§ - Educationsal Diagnadtic

p— SPED) Stutent Age Range: (012 Age 5 WG] Theowgh 21 ~]
N — —
Sualf Chasaification: 371 - Eaucational Dugrostom )i Moty Nerstns:
ESCAESA [Senost Crstnct brptoves ~] R
~ e
Ensome —

Ill. Finance Domain

Third Level Submission
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Review TSDS Web-Enabled Data Standards for the Finance domain.

The Finance domain includes financial information captured in accounts (both actuals and
budgeted).

1. Add crosswalks.
Add crosswalks
Finance > Tables > TSDS Crosswalks

Map financial data from the LEA's set of accounts to TEA's Chart of Accounts for both the
current and previous file IDs.

o Verify the TSDS crosswalks are correct.

o Verify that there are not crosswalks for the automatic crosswalks processed by
ASCENDER.

o Review the Automatic Crosswalks section on the Finance TSDS Crosswalk Tables
page.

o If a crosswalk is created on this page, it will be used and applied
throughout the TSDS reporting process.

o Automatic crosswalks are applied AFTER crosswalks created on this
page are applied.

o If you choose to use crosswalks, note that no updates are made to the
Finance application. Any updates must be made manually in the
Finance application.

A 1 \
-
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Crosswalk Type: | vl

A -

040 Budget

041 Budget -
045 Budget -
046 Budget -
047 Budget -

048 Budget

049 Budget -

055 Budget

056 Budget -

059 Actual

060 Actual -

061 Actual

062 Actual -
063 Actual -
064 Actual -
066 Actual -

D67 Actual
069 Budget
070 Actual

[ R )

Fram Org to Org
From Pgm to Pgm
Fund/SO to Pgm
Fund to Fund

0Obj to Obj

Func to Func

Funds to Omit
Fund/Func/SO to Pgm
Fund to Pgm
Fund/S0 to Pgm
Fund to Fund

Org to Org

Obj to Obj

Fund to Pgm

Func to Func
Fund/Func/S0 to Pgm
Funds to Omit

- Fund/Pgm to Pgm
Fund/Pgm to Pgm

As an example, a one-campus LEA that budgets and books expenditure records to
campuses 101 and 001 should establish a crosswalk to move expenditures from
Organization code 101 to Organization code 001.

TIP: When

performing a crosswalk, note that it transfers all items from the

old to the new. For example, if using 040 Budget - From Org to Org and you
move Org 101 to Org 001, all line items from Organization code 101 will be

moved to Organization code 001, not just a specific line item.

Crosswalk Type: [0-10 Budget - From Org to Crg Retrieve ] [ Print

Delete AFrom To
[} (101 ] [oo1 |
@ J ]

2. Verify Budget data.
Verify Budget data

Budget data is extracted from Finance for applicable funds. The totals include entries
made into the system until the end of October or accounting period 10. It is
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recommended that all budget amendments be entered by the PEIMS Fall Snapshot date,
which is the last Friday in October.

GENERAL LEDGER INQUIRY GENERAL LEDGER ACCOUNT SUMMARY EMPLOYEE DISTRIBUTION LIST INQUIRY OVER EXPENDED ACCOUNT SUMMARY

Processed Current Period: 09 Mext Period: 09 [] Batance Accounts Only [ Include Fund Totals [_] Exclude Objects 61XX
Fund Func Obyj Sobf e PO s==s mmmn r
Account Code: oox )i [ox )i [ooo)i (e )i [oec )i (x)F [ec )i (x )3 [ [_re J [_ese ]

Date Run: Inik .
Crity Dist - ‘;o" Page:1of 3
Processed [ Current (09) B Next () B mmmnmxnln File ID:C

Est Revenue' Rizd Revenus/

Account Mumber Description A, ki Er Exs Balance

1% 11 6113 00 001 & 11 0 00 SALARIES - TEACHER & PROFESS 4457 463.00 0.00 -5.368.80 4482 83780
% 11 613 00 001 6 22 0 00 SALARIES - TEACHER & PROFESS 000 0.0a 0.00 0.00
W 1 6N 00 001 6 23 0 00 SALARIES - TEACHER & PROFESS -307.200.00 0.00 0.00 -307 200.00
1 1 613 00 001 6 24 0 00 PROFESSIONAL SALARY =121.830.00 0.00 0.00 12183000
1% 11 6119 00 001 6 25 0 00 SALARIES -1,000.00 0.00 0.00 -1,000.00

The following data is reported:

o Fund
o Function
o Object
= Report 5XXX-8XXX
= 61XX are collapsed into 6100, 62XX into 6200, 63XX into 6300, etc.
o QOrganization
o Fiscal Year
o Program Intent
o Amount
o Begin & End Date (time/date stamp assigned at the time of data entry; not the
transaction date)

District Administration > Tables > District Information > Fall Finance TSDS Data

This tab is used to retrieve and edit Fall TSDS financial data, allowing for corrections to
Budget and Payroll data in the TSDS staging tables. The staging area temporarily holds
data before it is submitted to the Texas Education Agency (TEA) (i.e., promoted to the
Operational Data Store (ODS)).

The data on this tab is obtained from the latest Fall extracts after period 10 is closed,
incorporating all TSDS crosswalks, automatic crosswalks, and data summaries.
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Accounts are summarized by fund, function, object class (6100), organization, and
program intent code. For instance, 199-11-6119.00-001-511000 will display as 199 11
6100 001 11. Users should cross-reference balances with the Finance application and
may need to combine amounts to ensure accurate budget reporting.

Notes:

o Data cannot be duplicated. Duplicated data will receive an error upon
submission.

o Enter data carefully on this tab. Incorrect or improperly formatted data may
cause errors upon submission.

TSDS Extract Notes:

The budget and payroll data extracts are run nightly along with the other TSDS extracts
until accounting period 10 (October) is closed in Finance.

o After period 10 (October) closes, the budget and payroll data extracts are paused
for the current school year.

o After period 10 (October) closes and the nightly extract is run, the Fall Finance
TSDS Data tab in District Administration is enabled allowing users to begin
making corrections to budget and payroll data.

Finance TSDS Crosswalk Tables

PORESS  CAMPUS WAME/ADDRESS  PAYROLL FREQUENCIES — REPORTING CONTACT  SHARED SERVICES ARRANGEMENT  FUNDBALANCES  FALL FINANCE TEDS DATA

Fung Oty Org Fsol ¥r Fgm
s 8

Fumad
Coocdi (e Cooo)i (oo ) () (=i

School Fear Fund Fune Oy Oeg Fucd ¥r Pgm Budget Amount Begen Date End Date Statud  Action

Mo Rowd

O Click ™ to select 1 - Budget.

O In the Unique Staff ID field, type the 10-digit unique staff ID assigned to the staff
member by the Texas Education Agency and click Retrieve.

O Make any necessary budget corrections (such as code or amount changes) to the
Budget data in the TSDS staging tables.

O Click Save.

Notes:
Budget Data with an ODS ID

o To delete a previously submitted record, set its amount to zero and insert a
new record with the correct data. This will mark the record for deletion and
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resubmission.
o Account codes (rows) are validated to prevent duplicate records.

Change Original Record New Record
Account Code or Begin Status = R - Resubmit, Action = D - L. -
New, Action = | -
Date Delete
Insert
Amount or End Date Status = R - Resubmit, Action = U -
Update
Amount = 0 (zero) Status = R - Resubmit, Action = D -
Delete

Records without an ODS ID

o Changes will not affect the Status or Action (Status = N - New, Action =/ -
Insert).

3. Verify Payroll data.
Verify Payroll data
Payroll > Maintenance > Staff Job/Pay Data > Distributions

Verify all account codes, amounts, and activity codes. All employees should have at least
one row with Activity Code 78 (non-salary) or 80 (Base Salary).

Note: Activity Code 78 is generally used for Volunteer Services where there is zero
pay. If pay should be reported, use valid Activity Codes such as 02, 79, or 80.
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Employee: (000101 : AUSTIN. AMBER SUE ] [ Retricwe ] l Directory ]
PAY INFO' JOBINFO DISTRIBUTIONS DEDUCTIONS LEAVE BALANCE
Delete  Details Job Code Extra Duty Account Type Account Code Amount Percent
0] 0136 - SPECIAL PROGRAMS COORDINATOR 45 - COUNSELOR G 199-31-6119.00-001-611000 1000000 17.286%
m @) 0136 - SPECIAL PROGRAMS COORDINATOR G 199-31-6119.00-001-611000 4784900 B2714%
Total: 57,849.00 100.000%
Rows: 20f 2 Refresh Totals Add
Job Code: [0138 - SPECIAL PROGRAMS COO v
Extra Duty Code: [ u] Activity Code: [EO Base Salary v Re-sort
Account Type: |G Standard gross pay ~| TRS Grant Code:
I Account Code:  [199-31-6119.00-001-611000 ) I Worker's Comp Code:  PROFESSIONALS
Hozarntian SALARIES - TEACHER & PROFESS Expense 373 l'r Account used in ASE distr w
I.c\mount 47,849.00| out of 57,849.00 I Emeloyer Contribution:
FEEITE ELE Performance Pay: D

The following data is reported:

o Amount - Indicates the dollar value paid to a staff member for a given payroll
activity per year.
o Account Code -

= Fund - Identifies the fund group and specific fund (when applicable) for the
staff payroll financial data.

» Function - |dentifies a general operational area and groups together related
activities.

» Object - Identifies an account, a transaction, or a source of funds. It indicates
the major account group to which a transaction is posted or the associated
monies are related.

» Organization - Identifies the unique organizational unit within the local
education agency with which the account is associated. For campuses, this is
the three-digit campus number registered with the Texas Education Agency.
For non-campuses, this must be one of the administrative units required in
the Resource Guide, or 998 or 999.

= Fiscal Year - The last digit of the fiscal year (e.g., the fiscal year is 6 for the
2025-2026 fiscal year).

* Program Intent - Identifies the cost of instruction and other services
directed toward a particular need of a specific set of students. The intent (the
student group toward which the instructional or other service is directed)
determines the PayrollProgramintent, not the demographic makeup of the
students served.

= Activity Code - Indicates the types of duty for which a staff member receives
a salary, salary supplements, or bonuses. PayrollActivity does NOT include
fringe benefits such as group health and life insurance, workmen's
compensation, sick leave, and others under Object value 6140.
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District Administration > Tables > District Information > Fall Finance TSDS Data

This tab is used to retrieve and edit Fall TSDS financial data, allowing for corrections to
Budget and Payroll data in the TSDS staging tables. The staging area temporarily holds
data before it is submitted to the Texas Education Agency (TEA) (i.e., promoted to the
Operational Data Store (ODS)).

The data on this tab is obtained from the latest Fall extracts after period 10 is closed,
incorporating all TSDS crosswalks, automatic crosswalks, and data summaries.
Accounts are summarized by fund, function, object class (6100), organization, and
program intent code. For instance, 199-11-6119.00-001-511000 will display as 199 11
6100 001 11. Users should cross-reference balances with the Finance application and
may need to combine amounts to ensure accurate budget reporting.

Notes:

o Data cannot be duplicated. Duplicated data will receive an error upon
submission.

o Enter data carefully on this tab. Incorrect or improperly formatted data may
cause errors upon submission.

TSDS Extract Notes:

The budget and payroll data extracts are run nightly along with the other TSDS extracts
until accounting period 10 (October) is closed in Finance.

o After period 10 (October) closes, the budget and payroll data extracts are paused
for the current school year.

o After period 10 (October) closes and the nightly extract is run, the Fall Finance
TSDS Data tab in District Administration is enabled allowing users to begin
making corrections to budget and payroll data.

O Click ™ to select 2 - Payroll.

¥oar I3 ]

DESTROCT WAME F ADORESS  CAMPUS NAME  ADDRESS  PAYROLL FREQUIEMCIES  REPORTING CONTACT  SMARDD SERICES ARRANGEMENT PUND BALANCES  FALL FINANCE TSOS DATA

Fnc O%y g
A (1

Schood Yoar Unigue SEaf 1D Fund Fune Of§ Org Fecl¥r Pgm Pay Amount Py Activity BeginDate Endd Date Status Action

Pic Hows

O In the Unique Staff ID field, type the 10-digit unique staff ID assigned to the staff
member by the Texas Education Agency and click Retrieve.

O Make any necessary payroll corrections (such as code or amount changes) to the
Payroll data in the TSDS staging tables.
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District Administration

O Click Save.

Notes:
Payroll Data with an ODS ID

o To delete a previously submitted record, set its amount to zero and insert a
new record with the correct data. This will mark the record for deletion and
resubmission.

o Account codes (rows) are validated to prevent duplicate records.

Change Original Record New Record
Account Code or Begin |Status = R - Resubmit, Action =D - L =.N -

New, Action =/ -
Date Delete Insert

Status = R - Resubmit, Action = U -
Update
Status = R - Resubmit, Action = D -
Delete

Amount or End Date

Amount = 0 (zero)

Records without an ODS ID

o Changes will not affect the Status or Action (Status = N - New, Action =/ -
Insert).

IV. TSDS Level 1 Errors

This page is used to view and print a listing of Level 1 errors that occurred in various
domains/entities when the API interface files begin processing into the TEA database.
ASCENDER does not control the content of these errors.

All TSDS Level 1 Error reports are displayed and printed in landscape orientation by default.

1. Review/correct TSDS Level 1 Errors.
Review/correct TSDS Level 1 Errors
District Administration > Inquiry > TSDS Level 1 Errors
Review TSDS Level 1 errors on a regular basis and correct data as needed. If not

addressed, these errors will prevent data from flowing to the Operational Data Store
(ODS).
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Print l | Extract Errors Reprint ] lE dract Prior Year Rep.’:”'.] [ Extract Budget Reprint ] [ Extract Payroll Reprint ]

TSDS Level 1 Errors For

O  Domain Entity Number of Emors
D Student kdentification and Demographics Student Parent Association 76
D Teaching and Leaming Staff Soction ASS0CtIon 1L
D Enrollment Stwdent School Association 2
D Alternative and Supplemental Services Student Title | Part A Program Association
D Student Attendance Student School Attendance Event

Student Attendancs Bask: Reporting Period Attendancss 3

Student Attendance Stedent Program Attendance Event

d 1 *

You can print various reports using the following options:

o Select the checkbox next to the domains (rows) to be included in the report and
click Print. This prints errors associated with the selected Domain > Entity.

o Click Extract Errors Reprint to display the processes that completed successfully
in the last extract as well as a list of errors that need to be corrected. This should be
the focus for most error resolution.

o Click Extract Prior Year Reprint to display data that was extracted for Mid-Year
PEIMS.

o Click Extract Budget Reprint to display Budget data most recently extracted for
Fall PEIMS.

o The Extract Payroll Reprint button displays Payroll data most recently extracted
for Fall PEIMS.

Note: If included in the report, the Action Type column displays the expected action
of the record that was sent to the Operational Data Store (ODS):

o | -Insert
o U - Update
o D - Delete

V. Data Quality Tips

TSDS Data Quality Checklist

Budget Data
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District Administration

ASCENDER Step

Breadcrumb

Finance > Click ¥ to display all funds. Verify all funds are valid for the 2026 Budget. If
Inquiry > not, create TSDS Crosswalks (Fund to Fund).

General Ledger

Inquiry BudgetFund - Table ID C145B

Click ¥ to display all functions. Verify all functions are valid for the 2026
Budget. If not, create TSDS Crosswalks (Function to Function).

TIP: Expense function codes should not be 00.

BudgetFunction - Table ID C146B

Click ¥ to display all objects. Verify all objects are valid for the 2026 Budget. If
not, create TSDS Crosswalks (Object to Object).

TIP: Expense object codes should not end with 0.

BudgetObject - Table ID C159B

Click ¥ to display all Program Intent Codes (PICs). Verify all PICs are valid for
the 2026 Budget. If not, create TSDS Crosswalks (Program Intent to Program
Intent).

TIP: Expense program intent code should not be 00.

BudgetProgramintent - Table ID C147B

Click ¥ to display all organization codes. Verify all organization codes are valid
for the 2026 Budget. If not, create TSDS Crosswalks (Org to Org).

Verify organizations 001-698 are tied to a campus ID in AskTED. If not, create
TSDS crosswalks as needed (Org to Org).

Click ¥ to verify accounts with PIC 91 are using function codes 36, 51 or 52.

Click ¥ to verify combinations:

* Org 701-750 should only be used in functions 41, 53, 99

* Function 71 should be used with object 65XX

* Funds 205, 255, 270, 429 should be used with PIC 24 rather than 30

* Expense objects (6XXX) should not be used with Org 000, 709-719, 726-749
or 800-997

* Expense Objects (6XXX) should not be used with PIC 00

* Expense Objects (6XXX should not use function 00)

Account Code Matrices in FAR

Click ¥ to verify the fiscal year for PEIMS Budget Funds. The fiscal year is 6 for
the 2025-2026 fiscal year. (Only applies to funds reported for Fall PEIMS: 199,
240, 420, 599)

Verify expenditures exist for object code 6491 to record Statutorily Required
Public Notices.

Verify at least one account code exists for instructional staff development
(function 13) with budget amounts.

Verify at least one account code exists for general administration (function 41)
with budget amounts greater than zero.
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District Administration

ASCENDER Step

Breadcrumb
Verify at least one account code exists for instructional resources and media
services (function 12 and object 6100-6600) with a budget and actual
expenditures greater than zero.
Verify at least one account code exists for guidance, counseling, evaluation
services or social work services or health services in function 31-33, object
6100-6600 with amounts greater than zero.
Verify at least one account code exists with object code 6212 for audit
services.
Verify one account code exists for Matching State Funds (object 5829) in funds
240 and 410.
Verify budgets in object 65XX are tied to function 71.

Staff Data

Active Employees:

Responsibility

ASCENDER Step

Breadcrumb
Verify the following fields are completed for all regular employees,
contracted instructional staff, and long-term substitutes:

Personnel > * Texas Unique Staff ID

. * DOB

Maintenance > |, Sex

Staff Demo >

Demographic * Race

. * Ethnicity

Information
Generate a user-created report to verify accuracy.
Staff Entity

Perlsonnel > Ensure the PK Teacher Specialization is added to all PK Teachers of Record.

Maintenance >

Staff Demo > PK Teacher Requirement - Table ID C207

Credentials
Ensure all TIA teachers have TIA data added. If TIA eligible, generate a user-
created report to ensure they also have Creditable Years of Service. This
is reported in Class Roster.
TIA Designation - Table ID C322
Ensure Responsibility records are complete and accurate for applicable staff.

Personnel >

Maintenance > . o , L .

Staff Demo > StaffEducationOrganizationAssignmentAssociation Entity

Responsibilities - Quick Reference Chart

Responsibility records with a Staff Service beginning with SE must have
Pop Served set to 06.

Population Served - Table ID C030

Responsibility records for aides must have Number of Students set to 0.
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District Administration

Maintenance >
Employment Info

ASCENDER Step
Breadcrumb
Personnel > Verify that active employees only have one employment type selected,

Employment Type or Retiree Employment Type.

Staff Type - Table ID C181

Verify Employee Status is 1-5 or A when data is ready to be sent. (TIP: It is
recommended to set the Employee Status to 0 - Pending while gathering
required data elements.

TSDS Best Practices for New Employee Records

Verify all employees with a Latest Re-employment Date do not have a
Termination Date. For re-hires, delete the Termination Date and
Reason.

Verify all regular employees have a Highest Degree.

Verify all employees have a Percent of Day Employed.

Verify professional staff have Total and In District years of experience.
(exclude current year in count)

Total Years Professional Experience

Verify all auxiliary staff have an Auxiliary Role ID with a Begin Date. Staff
who have an Auxiliary Role ID should have at least one payroll record
coded to object code 612X. For TSDS reporting purposes, multiple auxiliary
roles are allowed.

Auxiliary Role - Table ID C213

Verify all paraprofessional staff with a Paraprofessional Certification have
Para Cert selected with a Begin Date.

Paraprofessional Certification

Verify Employment Status. Only staff with an Employment Status of
01-05 and A are reported to PEIMS. When all employee data is complete and
accurate, change the Employment Status to include the record in the
nightly send job.

TSDS Best Practices for New Employee Records

Personnel >
Maintenance >
TSDS Days
Employed Set

Ensure all reported staff have Number of Days Employed.

StaffEducationOrganizationEmploymentAssociation Entity

Ensure all reported staff have a Percent of Days Employed.

StaffEducationOrganizationEmploymentAssociation Entity

Terminated Employees:

ASCENDER Breadcrumb Step

Employment Info

Verify the employee record has a Termination Date and

Personnel > Maintenance > Termination Reason.

TSDS Best Practices for Terminated Employee Records

Verify the employee record has an End Date for the Auxiliary
Role ID and/or Paraprofessional Certification.
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District Administration

ASCENDER Breadcrumb Step

Select Extract for TSDS to include the employee in TSDS Staff
Domain extracts regardless of their employment status.

Verify the employee record has an updated Employment
Status, if not, select the appropriate code.

Verify the employee record has an End Date on the

Personnel > Maintenance > Responsibility record if one exists.
Staff Demo > Responsibility

TSDS Best Practices for Terminated Employee Records

Payroll > Maintenance > Staff
Job/Pay Data > Pay Info

Verify the employee record has an Inactive Pay Status.

Personnel > Maintenance >
TSDS Days Employed Set

Verify the employee record has an End Date.

Payroll Data

ASCENDER
Breadcrumb

Step

Payroll > Reports >
User Created Report

Review employee distributions. Verify organization codes on all payroll.
No payroll expenditure codes should use org 000, 700, 709-719,
726-749, or 800-997.

Account Code Matrices in FAR

Verify admin staff coded to functions 41, 53, or 99 use valid org codes
701-750.

Account Code Matrices in FAR

Verify program intent codes on all payroll. No payroll program intent
codes should use org 00.

Account Code Matrices in FAR

Verify all staff have at least one payroll code with a Payroll Activity
code of 80.

Staff paid with object 6129 must have an Auxiliary Role ID or
responsibility with Staff Classification of 033 or 036 or Classroom
Position record of 05 in the Schedule.

Personnel > Tables >
Salaries > Extra Duty

Verify Business Allowances are set to Activity Code 79.

PayrollActivity - Table ID C018

The District PEIMS Coordinator is responsible for setting up the following, unless

0 other arrangements have been established.

Do not make changes to this information unless authorized.

ASCENDER Breadcrumb Step

District Administration > Verify that the As-of-Date and School Start Window (SSW)
Options > TSDS > Options Date fields have the correct dates.
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District Administration

ASCENDER Breadcrumb Step

Ensure that email address(es) are entered under Finance
Extract Distribution List and Personnel/Payroll Extract
Distribution List. These designated email addresses allow a
person or group of persons to receive extract emails.

District Administration >

Options > TSDS > Connection Verify the APl URL, Key, and Secret are accurate.

District Administration >
Options > TSDS > Domains &
Entities

Make selections on Domains & Entities as described in the
ASCENDER TSDS New School Year Best Practice Guide.
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